More Excel as a Tool to
Troubleshoot SIS Data for EMIS
Reporting
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Overview

* Basic Excel techniques can be used to analyze EMIS data
* From Student Information Systems (SISs)
* From the Data Collector
* On ODE EMIS reports

* This presentation will review Excel tools
* Help with the analysis of source data
* How source data relates to EMIS data reporting
e Reinforce and enhance Excel skills

EMIS
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Outline

* Excel Tabs and the Quick Access Toolbar

* Creating a Source Data File

* \V-Lookup, Conditional Formatting, and Pivot Tables
* Additional EMIS Tips, Tricks, and Shortcuts



Excel Tabs and the Quick
Access Toolbar
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Excel Tab Review

* FILE

* HOME

* INSERT

* PAGE LAYOUT
* FORMULAS

* DATA

* REVIEW

* VIEW

EMIS
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Excel Tab Review

FILE Frequently Used Tools for EMIS
e e Fill color ort Page Break Preview
L ] .
New Text Color Filter Zoom
* Open nspect Workbook Wrap Text Text to Columns  Arrange all
Detnre peimishing this file, be sware that
zlrl--fr-—v:-nnmnr- sries path Conditional Formatting Freeze Panes
' Save Contenl thal pecgle wetn disalaltie SDrt & FiItEr
. Save AS "'IITF':JI:i{.I:Iru.. et versoes ol 1k
- PAGE LAYOUT
* Prin _ _
Browser View Optians Pivot Table Insert Function Themes
Pirk whal s ¢ @ ses b s morkl . .
Text Box AutoSum Orientation
HOME HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW POWERPIVOT
== S
Cliob d D E?E Cut ']11 =LA A L — = =& Wrap Text |General
* Llipboar 53 Copy ~ t
Pa'ste * Format Painter I u = s - A E == &= Merge 8 Center ~ $ - % » %5 38
. Fﬂl"lt Clipboard e Font M Alignment M Number
EMIS
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Parts of a Worksheet Review

Quick Access Toolbar

N\
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(= B = Y I EE R BB i
File tab r’ HHkIE FSEE FAGE LAWDUT FIORAILILAS DATA FEVEM
== ) L il =1 . = " CEfErM E D] FeEel TR,
Ribbon Sl BT w- AKX = % - % r [ Fomet s Table -
wte .
- v - B - = 4= &-- "2 o 27 Coll SEpdes -
] i e . -
i1 e
i B o E ; H
Y
B Columns

g } FRows

Status Bar

Worksheet Tabs

Formula Bar
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= BFcemalk -

Zoom Slider
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Quick Access Toolbar

How to add a frequently used T sook1 - b

too I to yo u r Qu i C k Access lisert Page layout Formulas Data Review View ' 7. ma what you want to do
T I b . 3 . A AT | = - General
OO a r / ’i ~ Format Painter BJIU- - v v €= 3= EttergetCenter - $ ~% 6o
. Clipboard M on M Alignment T Number
1. Select a tab that contains - .

the tool / :
2. Right click on the icon =

Insert Page Layout Formulas Data  Review View ":.;::' Tell me what you

3. In the pop-up select Add to

Quick Access Toolbar [ 2 copy - A& " =1
. . Jafte ¥ Format Painter B 7 U-[H-|a- A- ===
4. The tool’s icon will appear Cbowd o .
in the Quick Access Toolbar

EMIS
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Quick Check

Excel can be intimidating.
Empower yourself by creating
an Excel environment that
works for you. Learn shortcuts
in Excel so that you can spend
more time working on your
data and less time figuring
out how to use Excel.

* Are you able to navigate the tabs
in Excel to find the tools you
need?

* Are you able to add tools to your
Quick Access Toolbar for ease of
use’?

* Are you getting more comfortable
with Excel?

EMIS
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Creating a Source Data File
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Source Data File

 Creating a source data file can be a quick way to analyze your data
before it makes it to the Data Collector

* Adding additional data from outside sources can enhance an all-in-
one source data file

* Cross check key EMIS reporting elements by filtering various
categories within your source data file

EMIS
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Frequently Used Source Data Fields

Last Name

First Name
State Student ID
EMIS ID

Date of Birth
Gender
Building IRN
Grade Level
Grade Next Year

How Received

Sent Reason

District Relationship
Percent of Time
District of Residence
Withdraw Reason
Effective Start Date
Effective End Date
Tuition Type

Homeless Status
Disadvantgement
Limited English
Disability Condition
Attendance Pattern
MOA IRN
Accountability IRN
Fiscal Year Began 9th
Diagnostic Results

EMIS
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Other Data Sources

Online Reporting System

Score Reports & Reports & Files ~

Retrieve Student Results & My Inbox

Create New Data File to Download

Step 1: Choose What

Report Type: Student Data e
Test: Ohio State Tests ~
Administration: Fall2016 ~

Tested Grade: All Grades

Download Fixed Width d

Format:

Filter By: ALL o
| Download |

I
My Inbox

Your data file(s) will remain available for 30 days.

| dekinbox (1) | Q Search Students | Add Roster | View/Edit Rosters l This page: (3 Help| & Print J

Step 2: Choose Who

School All R

Name Data m

Ba

Type Test Administration  Grade Date Created ~ @

Greenon Local SD (046235)  Student Data \ Csv /

District Oh:;iiﬁte Fall2016 Al 3113/2017 9:20 PM Qawnloay
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Data Collector

Midyear Student Collection (FY17)

Collection required for all Traditional Districts, JVSDs, ESCs, and State Supported Schools.
Source file(s) for GI, FS, FD, FB, FN, GD, GG, GE, FE, FC, FL, GJ, and GQ student record
types, labeled with the S reporting period, must be uploaded in EMIS manual format
through the Data Collector Data Sources tab. The DN record is also required to be
reported in this collection request as well, although there are a limited set of options
required. This collection request is for the data for school funding, Federal reporting, and
other required ODE reporting.

Submissions: January 05, 2017 - April 28, 2017

Expiration Date: April 28, 2017 (in 46 days)
Collection Request: 3
Status: The collection was submitted March 10, 2017 at 03:53:48
PM by Myers.
Validation Status: Level 1 Validation
_| Student Discipline Record (GD).csv 4 Validation Status: Level 2 Validation
.‘I e 17 Submission Status: Processing Completed (March 10, 2017 at 03:53:04 PM)
_-_I . . : Submission Number: 13 (attempt 1)
— Student Missing Override Record (FC).csv 4 e e Sl e e
_] Student Missing Report.csv > Review :
- ) Start Collection
_| Student Program Record {GQ).csv 73 Add Mew Scheduled Collection
T . Set Default Collection properties
_| Student Race Detail Record (Gll.csv 21
) Student Special Education Graduation Requirement Record 24
{FE).csv

EMIS
IR .
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Secure Data Center

14 (— Secure Data Warehouse > Reports Home

|
|

“ ‘

/]

Local Report Card Reports for Analysis
b E Reports Home Documents depicting your district/school preliminary Local Report Card and This folder contains reports for research and analysis. They are generally
Annual Yearly Progress results, based on the most current EMIS data. grids of data that can be manipulated, including sorting, rearranging rows and

columns, and drill-down operations.

Achievement data
K-3 Literacy data

Graduation data

Prep for Success data

Special education data
Gifted data

EMIS
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|

Secure Data Center, cont’d

Use the SDC export option

RELATED REPORTS

PROMPT DETAILS
zzz District 4-Year Graduation Rate - C1 )

Export Options

District 4-Year Graduation Rate - Current Data->Student Identifier

Export: I\.\Me report v Export Header and Footer: | Edit Custom Settings

(O Excel with plain text
7\ pa— ~ » :Y a"o\ etTic V . -q:-
O csv file format [[] Export metric values as text
(® Excel with formatting [] Export headers as text
O HM™M

O Plain text Delimiter: | Excel with formatting options:

[] Export Report Title

[] Export filter details

Remove extra column: IAutomabc v]

The SDC export option allows
multiple export formats

EMIS

Alliance




ODDEX SCR Export

Department i District Data Exchange (ODDEX)

Ohio

Home

of Education

SOES SCR History CCP

, 2017 v

ODDEX export will generate
a TXT file. From the TXT file,

Last Name SSID Display Mode
v Select All then copy the data
First Name Gender Conflict Status .
e from the TXT file
| scr export - Notepad
File Edit Format View Help
bSID First Name Last Name Conflict Code Conflict Effective Dates Reporting LEA1 IRN
<
A B C D E B G H J
Conflict LEA1 L
I N Cel I Al) paste - Effective Reporting Reporting LEA]: Percent |[Admission |\
Last Name |Conflict Code|Dates LEAL IRN LEAL1 Name |LEA1 Date Range Of Time Date 1
the data from the STIC 1/4/2017 123456|ABC Local  |09/26/2016 - Current 9/26/2016]]
STIC 1/20/2017 123456|ABC Local 07/01/2016 - Current 8/1/2013|1
TXT fl I e STIC 1/4/2017 123456|ABC Local 01/04/2017 - Current 1/4/2017|1
WTIC 1/4/2017 123456|ABC Local 07/01/2016 - 07/01/2016 100| 8/26/2015|3
STIC 1/4/2017 123456|ABC Local 07/01/2016 - Current 12/8/2011|N
eTI 1/A/2n17 122ACEIADC | ~pm] NZ/N1/9016 _ Crirrmmt = ofig/7nnAal N
EMIS
17
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Combined Source Data File Example

e Source Data File — 12t Grade
Students

e Special Education_ Graduati
on_Requirement_(FE) —
Assessment Exemption
preview/review file

551D FIRST NAME LAST NAME STUDENTID GRADE DISABILITY CONDITION
KQ3120909 [ETHAN THOMAS 123467 12 12
PQO9733522 [OLIVIA WILLLAMS 123458 12 *
IX6825340 |(LILAM JOMES 123459 12 <
IX9047510 |OLIVER WALKER 123478 12 *
I¥Y85386474 |ENMMA SMITH 12345 12 <
JTE837916 |SOPHIA BROWN 123460 12 15
JMNS602659 |AVA MILLER 123462 12 =
PP7370386 |WILLIAM TAYLOR 123465 12 10
JES216291 |ABIGAIL JACKSON 123468 12 10
DISABILITY
CONDITION OGT-R OGT-W ¢
10 Y N
15 | Y Y
| |
12 y y
10 Y Y

EMIS
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Combined Source Data File Example cont’d

This combined Source Data File now includes Assessment requirements
for 12t grade students with a disability

551D - |FIRST NAME| ~ |LAST NAME| ~ |STUDENT ID ~ | GRAD-T| DISABILITY CONDITIOI-T OGT-R |~ OGT-W |*/OGT-M |* OGT-5 |* OGT-C |~

KQ3120909 |ETHAN THOMAS 123467 12 12 ¥ N N ¥ ¥

JTEE37916 |SOPHIA BEROWNM 123460 12 15 Y M Y M Y

PP7370336 |WILLIAM TAYLOR 123465 12 10 ¥ N ¥ ¥ ¥

JE5216291 |ABIGAIL JACKSON 123468 12 10 Y M Y Y M

UT5745888 |Derik Jeter 321654 12 13 Y N N Y Y
EMIS
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Cross-Check Key EMIS Reporting Elements

* Are all Open Enrolled In and Out students marked correctly
* How Received and Sent Reason vs Student Address

e Are all students with a disability marked correctly
e Student Disability Category vs valid ETR dates

* Are your Concentrators marked for the current year
» Student courses vs CTE Program of Concentration Flag

* What other areas do you cross check in your source data prior to
collections

EMIS
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* Are you able to create your own

Quick Check source data File?

Having a source data file to  What other data sources are
review prior to data col!ectlon available to compliment your

will help to ensure quality d fila?

data is being collected at the source data tile:

time of a submission. * What multi-filtering cross-checks
Consider adding additional , ,

data from outside sources. can you do prior to collecting and

submitting data?

EMIS
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V-Lookup, Conditional
Formatting, and Pivot Tables
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V-Lookup

* Problem: Identifiable data is on one report, but not on another

* Solution: V-Lookup between Source Data File and report
e Student names
* Student test scores
e Student membership codes

 What do they have in common?
* SSID

* What reports might come back with just an SSID?

EMIS
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\ V-LOOkup ExerCise Be sure to;;_r:;;)ur SSID’s

alphabetically before

‘ | A - X o Jx  =nookup(az beginning the Vlookup
il | A B C D E F G process.
i 1 5_51[1_ _____ ‘LAET NAME | FIRST NAME LEA_IRN BLDG_IRM Result  Result_Description \D. /

¢ EI_F{LSEE_AI_AI_BEI___IZ]DKUF’[AEJ 12345 GROO000 Current graduation stafiss— S _ U a
3 MWERZIAS 12345 GRO00D Current graduation status | GRAD 0003 2
4 1 WZZAREE 12345 GRODOO Current graduation status | GRAD_0003 il
BJZ27939497 12345 GRO0DD Current graduation status | GRAD_0003 il
E KJE?D'I ?l:l'l # A0 d4dC P e A L 1 L. 1L 1 e b II'II'II'I"I ?[
7 |KrB440984 Function Arguments i 23 I
8 kMN37e18R4 T [
9 KO1743342 [
10 [KO3327576 4 Lookup_value A2 FRz| = 'IR5724489 ) I
11 S[ﬂ EBE?EI‘q Tah|e_arra]lr Eﬁq.:é =
12 MEWY COLLIN . —_—
11 Col_index_num Rz =
14 Range_lookup | =
15 |FILE B - ODE REPORT k : J
16 12018_GRAD_Cohort-Non-EOC Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you
17 specify. By default, the table must be sorted in an ascending order.
18

EMIS
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V-Lookup Exercise Steps

1. Open Source Data File - Sort Ascending by SSID and save (Do NOT close file)

2. Open report missing Student names Data Collector - 2018 GRAD_Cohort-Non-
EOC- Pts-Detail — Sort Ascending by SSID and save (Do NOT close file)

3. Use a new tab in Data Collector - 2018 _GRAD_Cohort-Non-EOC-Pts-Detail and
rename Sheet 1 Source Data

4. Copy and paste the data from Source Data File into the Source Data worksheet tab
into Data Collector — 2018 GRAD_Cohort-Non-EOC-Pts-Detail

5. Move State Student ID to column A (Both files)
Always move the SSID field to column A first in the files you will be using

6. Insert one column for last name and one column for first name into
Data Collector - 2018 _GRAD_Cohort-Non-EOC-Pts Detail

EMIS
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V-Lookup Exercise Steps, cont’d

7. In Cell B2 of Data Collector - 2018 _GRAD_Cohort-Non-EOC-Pts-Detail (LAST NAME)
click on the function icon.

A. The Insert Function pop-up should appear. Select VLOOKUP and OK
B. The Function Arguments popup should now appear.
DO NOT HIT ENTER/OK UNTIL ALL FOUR VALUES ARE INSERTED
C. Lookup_value - Data Collector - 2018 _GRAD_Cohort-Non-EOC-Pts-Detail, click in Cell
A2 (SSID)
D. Table_array — SOURCE DATA, Highlight area that you want the LOOKUP to look at then
press F4 to make the range absolute
E. Col _index_num - SOURCE DATA, 2 (column number the LAST NAME is in)
F. Range lookup - FALSE
8. Drag or copy down the VLOOKUP result to the end of column B in
Data Collector - 2018_GRAD_Cohort-Non-EOC-Pts-Detail
9. Follow the same steps to come up with the First Name column

EMIS
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V-Lookup Exercise Result

2
23
24
25
2k

2 M X &/ v =VLOOKUP(A2,'SOURCE DATA'IAL:C11,2 FALSE)

A B C 8] E F G H | J
33id LAST NAME FIRST NAME LEA_IRMN BLDG_IRMN Result  Result_Description Severity L2_rec_type cohor_ye
IR5724483 1,2 FALSE) =
[W4B27713 12345 GRO0D0 Current graduation status | GRAD_0003 201
J2246202 12345 GRO0D0 Current graduation status | GRAD_0003 201
J27939457 12345 GRO0D0 Current graduation status | GRAD_0003 201
KJ2?D‘|?D‘I Aaadr I Yulululnl A 1 AL Fy 1 Coh 0005 _?D‘l
KMa4405a4 Function Arguments _@ & 01
KIN3781864 - 01
k01743342 VIOOKLP - = 01
KO3327576 Lookup_value | A2 @ = IR572448%° 0
301685734 Table_array |'SOURCE DATA'IAL:C11 (] = {rssiar, Tast, first TR5724489", BALLA

NEW COLU . —
Col_index_num | ? m =2
Range_lockup | FALSE [ = Fase
FILE B - ODE REPORT - “BALLARD"

2018_GRAD_Cohort-Non-EOC| N

Looks for avalue in the leftmost column of a table, and then returns a value in the same row from a column you
specify, By default, the table must be sorted in an ascending order,

Range_lookup is a logical value: to find the closest match in the first column (sorted in
ascending order) = TRUE or omitted; find an exact match = FALSE.

Formula result = BALLARD

Help on this fundtion [ OK H Cancel |

(\

In this example, your final result in the Function Argument should

show the student’s Last Name after the “ = “ sign.

You will also notice that the SD1685794 does not have a match. This
means the SSID is not in your source data, so you will want to

investigate who the SSID belongs to.

A, B ]
1 |=sid LAST NAME FIRST BAME LEA_IRMN BLDG_|)
£ |IRE724488  BALLARD 12345
3 |MVEBZTI13 PAYTON 12345
4 |W22dB202  TAGG 12345
B [JZ7939457 BLAIR 12345
B (KJEZV0T701  BROWHN 12345
7 |KhB440884 TUCKER 12345
8 [KM3781864 PANYTOMN 12345
9 |KD1743342  LUICAS 12345
10 [KD3327576  MASSIE 12345
11 |SD16AE794 7 #nA
12 MEW COLUMMMNE
13
14
15 |FILE B - ODE REPORT
16 | 2018_GRAD_Cohort-Mon-EOQOC-Pts-Detail
17
13
EMIS
. 27
e
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Conditional Formatting

* Problem: How do | know who’s missing and who is not when comparing
two sets of data?

* Solution: Use Conditional Formatting between source data file and report

* What should they all have in common?
e SSID

 Compare a list of students from your SIS who were required to take a test
against the test results

 Compare a list of students in grades 12 and 23 against a list of students
who are reported as withdrawn with a code of 99 and a diploma date

EMIS
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nsert

~urt

= Y]
r"ﬂHE Ly — O

Formulas

DEF]

Review

View

Conditional Formatting Exercise

b/ Tell me what you want to do

[0 Conditional Formatting ~

M
)

Ll
)
4

ST\

X
23,
Té

-

LGt \D,}
W/

Each set of data being
compared should not have
duplicates within the main data

/

/

NS

ulls . - = - = Inserf]
) Calbr i A E=Ee- B Cene S
By $ - 0L 9 N5 orb-ere—te e < Delet
Pafte BIU- - Q- .E. = = = €=3= M i QCeII Styles ~ iil Form
Clipboard Font r Alignment | Number Styles Cells
Al - Jx SSID Duplicate Values X
A B C D Format cells that contain: 4
FIRST STUDENT| | (GE8i © | values with |Light Red Fill with Dark Red Text |~
1 |SSID NAME LAST NAME |ID GR/
2 |JT8837916 (|SOPHIA BROWN 123460 1 OK Cancel
3 |PP7370386 |WILLIAM [TAYLOR 123465] 1. —

EMIS
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Conditional Formatting Exercise Steps

1. Open the Source Data File — V-lookup and Conditional Formatting file

2. Click on the CF Source Data tab

3. Copy and paste the list of known SSIDs (column 0) to the bottom of Column A. These
were SSIDs from the Secure Data Center

4. Select Column A (SSIDs to compare)

5. Go to Home > Conditional Formatting > Highlight Cell Rules > Duplicate Values

6. At the Duplicate Values prompt, it should default to “Duplicate” values with “Light Red Fill
with Dark Red Text”. Select “OK”

7. All SSIDs that are in the SDC List will be highlighted in light red and have dark red text

8. Are students counting that should count? Who is missing? Who is on the list but shouldn’t
be?

EMIS
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Conditional Formatting Exercise

R Y . T g §
SIS a|e|e~Noviswini=

— o | ) | | - —
Do |~ |h |0 | P

2
2

A B C D E F

FIRST STUDENT EMIS

SSID NAME LAST NAME |ID GRADE |SITUATION

JTE8837916 |SOPHIA BROWN 123460 12 351

PP7370386 |WILLIAM TAYLOR 123465 12 355

KQ3120909 |(ETHAN THOMAS 123467 12 355

JE5216291 |ABIGAIL JACKSON 123468 12 382

KP6745575 |JAMES WHITE 123469 11 382

MC2155271 [EMILY HARRIS 123470 11 382

KO1739256 (JAMES MARTIN 123471 11 484

JT8837916

PUB370386

TO3120875

JE5216291

KP6745575

MC2158571 Secure Data Center

KO1739256 .

JS7547388 Flle - copy and PaStEd

KP6701486

LK5757368 data

Source Data File

In this example, any SSID that is in both lists
is now highlighted in light red and the font
color has changed to dark red.

When looking at your own data, who isn’t
appearing in your SDC file that should be?
Is there someone in the list that appears in
both the Source Data File and SDC file that
shouldn’t be?

EMIS
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Pivot Table

* Problem: Besides filtering, how do | create a summary analysis of data
that will still allow me to view the data as a whole if needed?

* Solution: Create a Pivot Table from your source data file
* This is an interactive summary report that you create

* Think about the end result before diving in
* View the recommended Pivot Tables to get an idea of different options

 What data do you want to know as a summary and how do you want to see
it?

EMIS
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Recommended Pivot Table Exercise

e
| FILE PAGE LAYOUT FORMULAS DATA REVIEW  VIEW POWERPI
)
EI O r‘<> = @i (WStore E A B C D 3 F G H 1 ) K L
" - e 1
PivotTable Pictures Online Shapes SmartArt Screenshot o‘M}'Apps . Bing People I EMIS D|STDF=
Pictures - - Maps Graph 1 IFIRST LAST SID  ETHNICITY GENDER GRADE SSID SITUATION RES |
Tlustrations add-ins 2 JEMMA SMITH 123456 W F 12 1Y8586474 302 284284]
3 INOAH JOHNSON 123457 W M 12 (054945828 302 444333
E12 4 louvia WILLIAMS 123458 W F 12 PQ9733522 304 262626
5 iLIAM JONES 123459 A7) [\l 12 IXAR25340 304 757575: -
I 3] :SDPHIA BROWN 1234860 Recommended PivotTables @ 2|
7 IMASON  DAVIS 123451
EMIS bl ~t_ ! o 250 . Count of LAST by GRADE and ETHNICITY
1 |FIRST LAST sID ETHNICITY GENDER GRADE SSID SITUATION RES ; MILLER 123462
2 [EMMA SMITH 123456 W F 12 1v8586474 302 284284 9 IACOB ON 123463 Count of LAST Column Labels | -
10 |ISABELLA  MOORE Count of LAST by DIST O... Row Labels |~ |1 M W Grand Toti
3 |NOAH JOHNSON 123457 W M 12 054945828 302 444338 11 WILAM  TAYLOR aaes Countat et o oo < 10 1
| Row Ll < F M Grand Total
4 |OUVIA WILLIAMS 123458 W F 12 PO9733522 304 262626 12 i ANDERSON | 123266 o o : 11 12 8
5 |LIAM JOMES 123459 W M 12 1%6825340 304 262626 13 JETHAN THOMAS | 173467 wanm o : 12 114
6 |SOPHIA BROWN 123460 W F 11 JT8837916 351 336336 14 iABIGAIL JACKSON 123468 ssse : : Grand Total 1 323
7 MASON DAVIS 123461 W M 10 002167428 351 844844 15 lJAMES WHITE 123469 — 2 =
3 AVA MILLER 123462 M F 12 JN5602659 351 444222 16 JEMILY HARRIS 123470 Sum of DIST OF RES by G..
|
9 |JACOB WILSOM 123463 12 JV2048972 353 444388 17 JAMES MARTIN 123471
18 |CHARLOTTE THOMPSON 123472 S5 f ST DF RES G Lol =
| Row Labels ~F M G
19 IMICHAEL  GARCIA 123473 " g 25
20 HARPER  MARTINEZ 123474 u snuas 2oL
Grand Total 570G GZIM0BS
21 |BENJAMIN  CLARK 123475 =
|
22 |ASHER LEWIS 123476 Count of LAST by GRADE .
23 JAVA LEE 123477
24 JOLIVER WALKER 123478 I E
25 |AMELIA HALL 123479 st =1 v orand ot
In order to have data populate 25/ADAM  AUEN 123430 || S
. 27 iLE‘\J‘I YOUNG 123481 o D
in the Recommended 28 WYATT __ GREEN 123482 J
. 29 Blank PivotTable Change Source Data... [ 0K ] ’ Cancel
PivotTable, you must have a 2 y )
group of data selected.

/ EMIS
BN
.%‘ 3
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Recommended Pivot Table Exercise Steps

1. Open your Source Data file and highlight the data that you want to include in
your summary

2. Next, select Insert > Recommended Pivot Tables

3. Scroll down through the Help tool’s recommendations as to what details you
would like to see in the Pivot Table

4. Select the highlighted Pivot Table you want to work with and click OK

5. A new worksheet will appear next to the original worksheet

6. Rename the new worksheet

EMIS
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Recommended Pivot Table Exercise Result

In this example we chose to
look at Ethnicity by Grade levels

You can adjust any of the views
by dragging them between the

filter criteria or back up into the
field selection area

New Worksheet with

PivotTable Fields v X

Choose fields to add to report: =
Count of LAST Column Labels |~
Row Labels | - |1 M W Grand Total FIRST -
10 1 1 /] LAST
11 1 2 8 11 SID -
12 114 15 A
Grand Total 1 323 27 rag fields betwdgn areas below:

FILTERS COLUMMNS

ETHMICITY &

ROWS VALUES
GRADE R Count of LAST ~

-

Defer Layout Update

Excel Recommended
Pivot Table

5% RECOMMEND - ® 1 *

Drag Fields in and out of your list or across to
Filters, Columns, Rows or Values to create the
final summary (Pivot Table) that you would like

EMIS
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Quick Check

V-Lookup, Conditional Formatting,
and Pivot Table tools can take your
ability to review, sort, and filter your
data to a whole new level.

The more you use these tools, the
easier it will be when analyzing
reports and sharing that data with
others in the district.

e What additional data sources can |
use for V-lookup to my source
data?

* Will Conditional Formatting help
with Secure Data Center (SDC)
reports?

 What ODE reports could |
duplicate with my source data by
creating a Pivot Table?

EMIS
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Additional EMIS Tips, Tricks &
Shortcuts
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Other Tools for your EMIS Excel Toolbox

Frequently used tips from other EMIS Coordinators have been included
with this presentation
* Changing uppercase names to proper case
* Calculating the number of calendar days between two dates
e Calculating a future date
* Calculating the age of a student as of a certain date
* Creating a table view of a worksheet
* Quick counts of column data
Excel Dashboard Reference Guide
Keyboard Shortcuts

EMIS

Alliance



IS e

Proper and Days Functions

D2 v fr | =PROPER(B2)
 Need to change student names from all upper
case to “Proper” case? A B | c [HOM ¢ | ¢ 6 H

e |nsert additional COlumn(S) nhext to the names 1 SSID FIRST LAST  First last  SID  FSStartDate End/Withdraw Date
2 [c17229552 HARRY  POTTER [Harry Ipotter 555649 8/17/2016 2/1/2017
* Incell D2, type =PROPER(BZ) 3 (CK3668609 KATIE ~ BELL  Katie Bell 555231  8/17/2016 2/1/2017
_ 4 EF3553572 AMELIA  BONES Amelia Bones 555899  8/17/2016 2/1/2017
* Incell E2, type =PROPER(C2) 5 |HB7565571 LAVENDAR BROWN LavendaiBrown 555748  12/1/2016 2/1/2017
« HARRY POTTER should now be Harry Potter 6 168556609 ARGUS  FILCH Argus Filch 555694  10/9/2016 2/1/2017

* How do you calculate how many days are

ro

between two dates (includes first and last days)? Jr | sz gey

* G2 = Beginning of the school year (8/17/16)

* H2 =End/Withdraw Date (2/1/17) s B L - '
SSID FIRST LAST  First last  SID  FSStartDate End/WithdrawDate Calendar Days
* Incell 12, type =DAYS(H2,G2+1) |Cm2s552 HARRY  POTTER Mary Potter 555649 8/17/2016 oy 167]
° The tOtaI num ber Of ca |enda r dayS W| ” CK3668609 KATIE BELL  Katie Bell 555231  8/17/2016 2/1/2017
EF3553572 AMELIA  BONES Amelia Bones 555899  8/17/2016 2/1/2017
pOpU late- HB7565571 LAVENDAR BROWN LavendaiBrown 555748  12/1/2016 2/1/2017
° Drag the result down the Column to f||| in the 68556609 ARGUS  FILCH Argus Filch 555694  10/9/2016 212017

rest of the fields.
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*\ Date Function

'+ Find the end date for an IEP, it is 1 year minus 1 day from the Event date
* Incell I3, type =DATE(YEAR(F3)+1,MONTH(F3),DAY(F3)-1)

 Foran ETR, itis 3 years minus 1 day from the Event date
* Incell N3, type =DATE(YEAR(K3)+3,MONTH(K3),DAY(K3)-1)

* TIEP and TETR have to be entered manually since the Event Date is the Adoption Date

13 v fr | =DATE(YEAR(F32)+1, MONTHI(F3),DAY(F3)-1)
A B C D E F G H | J K L M N
EVENT
1 SID  GRADE First last ~ EMIS DATE  IEPTYPE START  END DATE  ETRTYPE START  END

5/3/2016 IETR  5/3/2016
12/1/2016  RETR  12/1/2016{11/30/2019
9/2/2016 TETR  9/2/2016 MANUAL

21123456 1 Ellie Mays 5 5/3/2016 1EP  5/3/2016
3 |321&54 12 Derik Jeter 100 12/1/2016 RIEP  12/1/2016|11/30/2017
4 739456 6 Todd Williams 151 9/2/2016 TIEP  9/2/2016 MANUAL

EMIS
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Dated If Function

 Want to get a head start on your 5 & 6 year olds for

Federal Child Count? To help you determine a ; B #o | —oarempav)
students age as of a certain date you will find the A 5 c b £ F & n |
. . . 1 Age as of
formula listed below as a hE'pr' addition to your 2 |SSID FIRST  LAST  SID GR EMIS DISAB  DOB  10/31/2016
3 |FJ7229552 Joseph Walsh 998776 K 100 15 6/28/2011 5
Source Data 4 |SK3668609 Ty Joseph 838775 K 5 15 2/27/2011 5
5 |WF3553572 Chrissy Hynde 112233 K 100 05  5/2/2011 5
* Known Data: 6 |PB7565571 Erik Carmen 142536 K 100 05  4/3/2011 5
. 7 |LGBSS6609 Marc  Kozelek 635241 K 5 01  3/8/2011 5
e Date Of B|rth 8 |DX5675650 John  Stevens 748596 K 5 08 1/24/2010 6
9 |JH5766445 Raquelle Sweet 475869 K 5 12 9/5/2010 6
° Age as Of 10/3 1/16 10 |IP8140461 Nancee Wilson 586947 K 5 05 12/1/2010 5
11 |MR5062617 Kellie  Deal 142563 K 5 15 2/22/2011 5
° Disa b|||ty - Yes 12 |CG2903942 Tracey Chapman 595153 K 5 13  12/6/2010 5
13 [XC3295124 Teddy Lewis 753951 K 5 10 6/30/2010 6
* Grade = Kindergarten “
e In Ce” |3’ type =DATED|F(H3’$|$2’”Y") SOURCE DATA | SD AGE | SDC vs SOURCE @
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Tables

Have a large amount of data that you would like to
see as a table?
* Open your worksheet and select INSERT >
TABLE
* The range of data to be included in the table
will auto-populate
e Click OK
* Your worksheet will now be in a Table format

* You can select various types by going to
TABLE TOOLS > DESIGN > TABLE STYLES.

HOME = INSERT = PAGELAYOUT  FORMULA
Tables Ilustrations
Al - fr || ssiD
A B C D E
o
|
I
i FIRST  LAST STUDENT sn|
1 SSID NAME NAME ID GRADE
2 |FJ7229552 Joseph _ Walsh 998776 K
- I i '
3 |SK366860Ty| Create Table ¥ K
4 |WF355357Ch e e the qatat A
5 IPB?EESEF Eri ¥Whnere Is 2 Jdata ror your tables lil
=5A51:5L552 =
6 |LGB55660¢ M3 =
7 |DX567565(Jok 7] My table has headers
g |JH5766445Ra
|
9 1IP8140461 Na ok || cance |
10 IMR506261 Kek.
11 :CGEEIDEEI-!I:Tr'aCE‘,-' Chapman 5395153 K
12 lwr32951% Taddy | owyig 753951 K
EMIS
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Tables, cont’d

Want to change the table back to a
worksheet with no filters but keep the style
of the table?
* Select TABLE TOOLS > DESIGN > Tools
> Convert to Range
* When converting back to a worksheet
a pop-up will appear asking if you want
to convert the table to a normal range
e Select YES
* You'll notice the filters are gone, but
the table style remains.

A B C D E
1 551D FIRSTNAME LASTNAME STUDENTID  GRADE
2 FJ7229352 Joseph Walsh 998776 K
3 SK366860tTy Joseph BEETTS K
4 'WF3355357 Chrissy Hynde 112233 K
5 |PB756557: Erik Carmen 142536 K
6 LGB55660¢Marc Kozelek 635241 K
7 | DX567565John Stevens 743596 K
& JH5766445 Raquelle Sweet 475869 K
9 1P8140461 Nancee Wilson 586547 K
10 MR506261 Kellie Deal 142563 K
11 e an2od Tramoar Tl e e [ e ) K

EMIS

Alliance




Quick Calculations

 Want a quick AVERAGE, COUNT, or SUM of a
column? D1 \ fx | STUDENTID
* Highlight the column that you would like : c . :
this data on
 Look in the bottom right corner of the
worksheet and the AVERAGE, COUNT, FIRST STUDENT
and/or SUM will appear 1 SSID LASTNAME [NAME  |ID GRADE| ¢
* AVERAGE is the average of the selected 2 |CK3068609 |BELL KATIE 35231 1
cells 3 KX5675650 |Gettson  |lane 534958 1
- COUNT is the number of selected cells that | o [Vays E"iE_ 12546 1
contain data SOURCEL (& : [4 ;
e SUM is the sum of the selected cells AVERAGE: 351070.8615 COUNT:66  SUM: 22819606
* To add additional settings to the Status Bar,
‘ right click anywhere in the bar and check or
\ un-check what you would like to see EMIS
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Other Tools for Your EMIS — Excel Toolbox

Keyboard Shortcuts
Open Workbook <Ctrl> + <0O> To Cell A1 <Ctrl>  +  <Home>
Create New Workbook <Ctrl> + <N> To Last Cell <Ctrl>  +  <End>
Save <Ctrl> '+ <S> Cut <Ctrl> | + < X>
Preview and Print <Ctrl> + <P>» Copy <Ctrl> | + <C>
Close Workbook <Ctrl> + <W> Paste <Ctrl> @ + <V>
Right One Cell <Tab> Undo <Ctrl>  + <Z>
Left One Cell <Shift> + <Tab» Redo <Ctrl> @+ <Y>
Up One Cell <Shift> '+ Enter Find <Ctrl» =+ <F>
Select All <Ctrl> + <A> Replace <Ctrl> | + <H>
Select Entire Row <Shift>  + <Space> Bold <Ctrl> | + <B>
Select entire column <Ctrl>  + <Space> Italics <Ctrl> | + <|>
Fill Right <Ctrl> '+ <R> Underline <Ctrl>  + <U> EMIS
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Summary

* Creating an all in one source data file can be invaluable when
analyzing data

* Using shortcuts will decrease time spent retyping information that is
already there or is easily calculated

* Using the new skills you have learned will reinforce your knowledge
and will make it easier to continue learning more Excel
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Resources

* Microsoft Excel Help within Excel “?” Articles and Videos
e Google it

* Microsoft Excel Classes

* Your ITC

EMIS

Alliance



Questions?




